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Preface

This book introduces Autodesk® Inventor® 2020 and shows how to use
Autodesk Inventor to create and document drawings and designs. The
book puts heavy emphasis on engineering drawings and on drawing com-
ponents used in engineering drawings such as springs, bearings, cams,
and gears. It shows how to create drawings using many different formats
such as .ipt, .iam, ipn, and .idw for both English and metric units. It
explains how to create drawings using the tools located under the Design
tab and how to extract parts from the Content Center.

All topics are presented using a step-by-step format so that the
reader can work directly from the text to the screen. There are many
easy-to-understand labeled illustrations. The book contains many sample
problems that demonstrate the subjects being discussed. Each chapter
contains a variety of projects that serve to reinforce the material just pre-
sented and allow the reader to practice the techniques described.

Chapters 1 and 2 present 2D sketching tools and the Extrude tool.
These chapters serve as an introduction to the program. There are 38
Chapter Projects to help students apply the material presented.

Chapter 3 demonstrates the tools needed to create 3D models, includ-
ing Shell, Hole, Rib, Split, Loft, Sweep, and Coil. Work points, work
axes, and work planes are explained and demonstrated.

Chapter 4 shows how to create orthographic views from 3D models.
The creation of isometric views, section views, and auxiliary views is cov-
ered. In addition, a comparison between first- and third-angle projection is
presented using both ANSI and ISO conventions.

Chapter 5 shows how to create assembly drawings using both the
bottom-up and the top-down processes. The chapter includes presentation
drawings and exploded isometric drawings with title blocks, parts lists,
revision blocks, and tolerance blocks. There is an extensive step-by-step
example that shows how to create an animated assembly—that is, a draw-
ing that moves on the screen.

Chapter 6 covers threads and fasteners. Drawing conventions and
callouts are defined for both inch and metric threads. The chapter shows
how to calculate thread lengths and how to choose the appropriate fas-
tener from Inventor’'s Content Center. The Content Center also includes
an extensive listing of nuts, setscrews, washers, and rivets.

Chapter 7 shows how to apply dimensions to drawings. Both ANSI
and ISO standards are demonstrated, but the emphasis is on ANSI stand-
ards. Different styles of dimensioning, including ordinate and baseline, and
using Inventor’s Hole Table are presented. Applying dimensions to a draw-
ing is considered an important skill, so many examples and sample prob-
lems are included.

Chapter 8 is an extensive discussion of tolerancing, including geometric
tolerances. The chapter first shows how to use Inventor to apply tolerances
to a drawing. The chapter then shows how to calculate tolerances in various
design situations. Positional tolerances for both linear and geometric appli-
cations are included. The chapter introduces the Limits/Fits Calculator
located on the Power Transmission panel under the Design tab.

Chapter 9 shows how to draw springs using the Standard.ipt format
and the Coil tool. It also shows how to draw springs using the tools on the
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Spring panel under the Design tab. Compression, extension, torsion, and
Belleville springs are included.

Chapter 10 shows how to draw shafts using the Shaft tool under
the Design tab. Chamfers, retaining rings, retaining ring grooves, keys
and keyways, splines, pins, O-rings, and O-ring grooves are covered. The
chapter contains many exercise problems.

Chapter 11 shows how to match bearings to specific shafts using the
Content Center. Plain, ball, and thrust bearings are presented. An expla-
nation of tolerances between a shaft and bearing bore and between the
bearing’s outside diameter and the assembly housing is given. Both ANSI
and ISO standards are presented.

Chapter 12 emphasizes how to draw gears and how to mount them
into assembly drawings. Spur, bevel, and worm gears are introduced. The
chapter shows how to create gear hubs with setscrews, and keyways with
keys, and how to draw assembly drawings that include gears. There are
two new extensive assembly exercise problems.

Chapter 13 shows how to draw basic sheet metal parts, including fea-
tures such as tabs, reliefs, flanges, cuts, holes, and hole patterns.

Chapter 14 shows how to create and draw weldments. Only fillet and
groove welds are covered.

Chapter 15 shows how to design and draw cams. Displacement dia-
grams and different types of followers are discussed.

Chapter 16 is available online and includes two large project-type
problems. They can be used as team projects to help students learn to
work together to share and compile files, or they can be used as end-of-
the-semester individual projects. This chapter can be found on the web as
a supplement to the Instructor’s Manual at http://pearsonhighered.com/
irc. Instructors may distribute to students.
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Style Conventions in Engineering Design Graphics with

Autodesk® Inventor® 2020

Text Element

Example

Key terms—Bold and italic on first mention in the
body of the text. Brief glossary definition in margin
following first mention.

Create a work axis by clicking on the edge
of the block.

Inventor tools—Bold and follow Inventor capitali-
zation convention.

Click on the Line tool.

Toolbar names, menu items, and dialog box
names—aBold and follow capitalization convention
in Inventor tab, panel, or pull-down menu (generally
first letter capitalized).

The Design tab

The Modify panel

The 2D Chamfer dialog box
The File pull-down menu

Dialog box controls/buttons/input items—Bold
and follow capitalization convention of the name of
the item or the name shown in the Inventor tooltip.

Choose the Metric tab in the New File
dialog box.

Click on the Flush button on the Place
Constraint dialog box.

On the Assembly tab, set the Offset to
0.000 mm.

ONG 300/320 sat 76
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Orthographic
Views

CHAPTER OBIJECTIVES

orthographic views: Two-
dimensional views used to define a
three-dimensional model. (Usually
more than one view is needed to
define a 3D model.)

* Learn how to draw orthographic views  Learn about third-angle projection
e Learn ANSI standards and conventions e Learn how to draw section and auxiliary views
Introduction

Orthographic views may be created directly from 3D Inventor models.
Orthographic views are two-dimensional views used to define a three-
dimensional model. Unless the model is of uniform thickness, more than
one orthographic view is necessary to define the model’'s shape. Standard
practice calls for three orthographic views: a front, a top, and a right-side
view, although more or fewer views may be used as needed.

Modern machines can work directly from the information generated
when a solid 3D model is created, so the need for orthographic views—
blueprints—is not as critical as it once was; however, there are still many
drawings in existence that are used for production and reference. The abil-
ity to create and read orthographic views remains an important engineer-
ing skill.

This chapter presents orthographic views using third-angle projection
in accordance with American National Standards Institute (ANSI) stand-
ards. International Organization for Standardization (ISO) first-angle pro-
jections are also presented.

167



Front )
plane Db ject

Y

Figure 4-1

normal surfaces: Surfaces that are
90° to each other.

O

Fundamentals of Orthographic Views

Figure 4-1 shows an object with its front, top, and right-side orthographic
views projected from the object. The views are two-dimensional, so they
show no depth. Note that in the projected right plane, there are three rec-
tangles. There is no way to determine which of the three is closest and
which is farthest away if only the right-side view is considered. All views
must be studied to analyze the shape of the object.

Figure 4-2 shows three orthographic views of a book. After the views
are projected they are positioned as shown. The positioning of views rela-
tive to one another is critical. The views must be aligned and positioned as
shown.

Top
plane

Top view

S0
= |
Right )/ e Book
plane \

-~ Right side view
/< /Book
90°
Front view

Figure 4-2

Normal Surfaces

Normal surfaces are surfaces that are at 90° to each other. Figures 4-3,
4-4, and 4-5 show objects that include only normal surfaces and their
orthographic views.

Front / Front
Top

Right

Front

side

Front

Figure 4-3

Figure 4-4
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Figure 4-5

Front

Front

Hidden Lines

Hidden lines are used to show surfaces that are not directly visible. All
surfaces must be shown in all views. If an edge or surface is blocked

from view by another feature, it is drawn using a hidden line. Figures 4-6
and 4-7 show objects that require hidden lines in their orthographic views.

Figure 4-6 Figure 4-7

Figure 4-8 shows an object that contains an edge line, A-B. In the top
view, line A-B is partially hidden and partially visible. The hidden portion
of the line is drawn using a hidden-line pattern, and the visible portion of
the line is drawn using a solid line.

| /KHidpdoi”ﬂif:e
FA/E\J& >

|
I
I
1 Hicdden line A

Figure 4-8

portion

T T T T
R B
A B AB
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Figures 4-9 and 4-10 show objects that require hidden lines in their
orthographic views.

Fe—-
|
I
Figure 4-9 Figure 4-10

Precedence of Lines

It is not unusual for one type of line to be drawn over another type of line.
Figure 4-11 shows two examples of overlap by different types of lines.
Lines are shown on the views in a prescribed order of precedence. A solid

T T Continuous lines that
Gc\p\ | cover hidden lines

po2
L
I 2

L —— Two hidden lines

N1
i

/ Centerli Z
Front thoteneftrely?gs Continuous line that
beyond a continuous covers o centerline
line . \_meg
o
genc®
prect

Continuous line
covers
——————— Hidden line

covers

Centerline

Figure 4-11
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line (object or continuous) takes precedence over a hidden line, and a hid-
den line takes precedence over a centerline.

Slanted Surfaces

slanted surfaces: Surfaces that are Slanted surfaces are surfaces drawn at an angle to each other. Figure 4-12

atan angle to each other. shows an object that contains two slanted surfaces. Surface ABCD appears
as a rectangle in both the top and front views. Neither rectangle represents
the true shape of the surface. Each is smaller than the actual surface.
Also, none of the views shows enough of the object to enable the viewer to
accurately define the shape of the object. The views must be used together
for a correct understanding of the object’s shape.

B Not true shape
of plane
Foreshortened view
A

not true size

of plane
Slanted
surface Pro jection
B \ C lines
\ Profile view
A | D C.B CB
B v ¢
A D D,A
Not true shape
of plane
Figure 4-12 Figure 4-13
Figures 4-13 and 4-14 show objects that include slanted surfaces.
Projection lines have been included to emphasize the importance of cor-
rect view location. Information is projected between the front and top views
using vertical lines and between the front and side views using horizontal
lines.
Figure 4-14

Compound Lines
compound line: A line that is

neither perpendicular nor parallel to A compound line is formed when two slanted surfaces intersect. Figure 4-15
the X, Y, or Z axis. shows an object that includes a compound line.
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Figure 4-15 Compound line

ez
™.

Oblique Surfaces

oblique surface: A surface that is An oblique surface is a surface that is slanted in two different directions.
slanted in two different directions. Figures 4-16 and 4-17 show objects that include oblique surfaces.

B ¢ B .
B
0/ E
c
A D

D FooA

A B A B D

F

3 F E
D LD C A B A B
Figure 4-16 Figure 4-17

Rounded Surfaces

Figure 4-18 shows an object with two rounded surfaces. Note that as with
slanted surfaces, an individual view is insufficient to define the shape of a
surface. More than one view is needed to define the surface’s shape accu-
rately.

Figure 4-18

-
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LR

Convention calls for a smooth transition between rounded and flat sur-
faces; that is, no lines are drawn to indicate the tangency. Inventor includes a
line to indicate tangencies between surfaces in the isometric drawings created
using the multiview options but does not include them in the orthographic
views. Tangency lines are also not included when models are rendered.

Figure 4-19 shows the drawing conventions for including lines for
rounded surfaces. If a surface includes no vertical portions or no tangency,

no line is included.

Tangency line

Tangency line

/

Vertical
/_ surfoce

-

Figure 4-19

Runout

Figure 4-21

No vertical Tangency
surfoce

Figure 4-20

Figure 4-20 shows an object that includes two tangencies. Each is rep-
resented by a line. Note in Figure 4-20 that Inventor will add tangent lines
to the 3D model. These lines will not appear in the orthographic views.

Figure 4-21 shows two objects with similar configurations; however,
the boxlike portion of the lower object blends into the rounded portion
exactly on its widest point, so no line is required.

Orthographic Views with Inventor

Inventor will create orthographic views directly from models. Figure 4-22
shows a completed three-dimensional model. See Figure P4-7 for the model’s
dimensions. It was created using an existing file, BLOCK, 3HOLE. It will be
used throughout this chapter to demonstrate orthographic presentation views.

Figure 4-22
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EXERCISE 4-1 Creating an Orthographic View

KN Start a new drawing, click the Metric tab, and select the ANSI (mm).

idw option.

See Figure 4-23. ANSI stands for American National Standards Institute.

Figure 4'23 I Create New File

v | Templates

v [ enus
English
[ Metric
MoldYesign

1. Click here

2. Click here

3. Click here
—

¥ Part - Create 20 and 30 objects.

Sheet  Sheet Standard Standard
Metal  Metal  (DIN.ipt (mm).ipt
(DIN)igt (mm).ipt

¥ Assembly — Assemble 2D and 3D components

ﬁ ﬁ & & & ‘;E:iSEHdard(mm)‘\ut

Mold  Mold  Stendard Standard | TEo e
Design  Design (DIN).iam {mm)iam (;N';“ Units: millmeter
(DIN)iam (mm).iam e Materisk Generic

This template creates a 2D or 30

5 & & 5 E object composed of features and one
or more bodies.

Weldment Weldment Weldment Weldment Weld
(BS)iam (DINjiam (GB)iam (ISO).iam (IS

Draing - Create an annotated document
A W W
owg =] et [BE  oue

ANSI  ANSI  BSldwg BSlidw DIN.dwg T
(mm).dwg (mm}.idw

Ed = j-

=3 Click Create.

Create | | Cancel

Project Fle: |Defaultp) || Projects.

The drawing management screen will appear. See Figure 4-24.

e - 09= 0hE +°

Figure 4-24
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Click the Base tool




N Click the Base tool located on the Create panel under the Place Views
tab.

The Drawing View dialog box will appear. See Figure 4-25.

Figure 4-25

Drawing View >
Component Model State Display Options  Recovery Options
File
<Select Document>
Representation
Style B
®%
[CJRraster View
Click here - |f.} |y
[Era—
Scale e
1:1 L
3 Click the Open an existing file button.
The Open dialog box will appear. See Figure 4-26.
Figure 4-26 I Open *
@ Libraries Lookin: [ | | Mr2020

(] Content Center Files

o T I
Chapter3 w/ BLOCK, 3HOLE BLOCK
1. Click here -

Fiename:  [BLOCK, 3HOLE v

Fles oftype: | Inventar Fes ("ot “iam “pr) 5

S g )
Last Saved: Autodesk Inventor 2020 (24.0.16800.0000) 2. Click here
e O gy | optons. T Open ]| concel |

=8 Select the desired model. In this example, the model’s file name is
BLOCK, 3HOLE.

=8 Click the Open box.
The Drawing View dialog box will appear. See Figure 4-27.
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File

Representation
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G Dee

Component Model State  Display Options Recovery Options

<Select Document>

12

Style
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[(Jraster view
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Cancel
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Figure 4-27
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Figure 4-28

EA Ensure that the Hidden line option is active, and click OK.

Figure 4-28 shows the resulting orthographic view. The selection of ori-
entation will vary with the model’s original orientation.

The screen will include a border and a title block. The lettering in the
title block may appear illegible. This is normal. The text will be legible
when printed. The section on title blocks will explain how to work with title
blocks.

EXERCISE 4-2 Creating Other Orthographic Views

EB The view shown in Figure 4-28 will be defined as a top view. Click and
drag the border around the view and move it upward on the drawing
screen. Click the Projected View tool on the Create panel under the
Place Views tab.

=8 Click the view already on the drawing screen.
EEB Move the cursor downward from the view.
A second view will appear.

EEB Select a location, click the left mouse button to place the view, then
click the right mouse button and select the Create option.

Figure 4-29 shows the resulting two orthographic views. The initial view

is defined as the Top view. This is a relative term based on the way the
model was drawn. The initial view can be defined as the Top view, and the
second view created from that front view.

EXERCISE 4-3 Adding Centerlines

Convention calls for all holes to be defined using centerlines. The views in
Figure 4-29 do not include centerlines.
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Figure 4-29

EN Click the Annotate tab.
See Figure 4-30.
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- @ BLOCK, 3HOLE

N

3. Click the hole’s edge

Figure 4-30

IEB Click the Center Mark tool located on the Symbols panel under the
Annotate tab.

EB Move the cursor into the drawing screen and click the edges of the
holes in the top view. Right-click the mouse and select the OK option.

EEX Click and drag the individual center lines for each hole in the Top view
to create a single center line through all three holes as shown. When
the cursor is moved onto a center mark, green-filled circles will appear.
Click and drag these circles to form a single center line.
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See Figure 4-31.

IE8 Click the Centerline Bisector tool located on the Symbols panel under
the Annotate tab.

I8 Click each side of the holes’ projections in the front view.

Vertical centerlines will appear. See Figure 4-32.

[T
W

Move the cursor onto the center marks. Green
Center marks filled circles will appear. Click and drag the lines to

form a single horizontal center line. Extend the

center lines beyond the edge of the part as shown

Figure 4-31

o |4 e = - Bl Hole -
A = o B | O

= = ision ~
Centerine Bisector Balloon
neral A

Table

Creates a osgterline bisecting two edges.

Press F1 for morahelp |

1. Click the
Centerline Bisector

2. Click each of the two edge
lines that define the hole

Centerline Bisector

Figure 4-32
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EXERCISE 4-4 Editing the Size of a Centerline

If the centerline patterns are too small or too big for the given feature, they
may be edited to create a more pleasing visual picture.

KN Click the Styles Editor tool located on the Styles and Standards panel
under the Manage tab.

Click the + sign to the left of the Center Mark heading, and select the
Center Mark (ANSI) option. See Figure 4-33.

IEEl Change the center mark values as needed.
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arameters  Styles Editor ™ 2= Replace Model = Zone Boder L2 Symbo Add Rule S e Editor Batch Publish &
&% Purge Reference 45 iTrigger
rameters * Styles and Standards Insert Define iLogic = Content Center
=]« E— . . .
P = | 63 style and Standard Editor [Librery - Read Only] 1. Click the Manage tab. 2. Click the Styles Editor tool *
- <% Standard | Back | ‘ Mew... | Save Resst F ‘anl Styles Vii
L Default Standard (ANST-mm)
,@ —— Center Mark Style [ Center Mark (ANSI) ]
=, -i'- Center Mark
L Mark A
5 |- @osunaom . B
l‘i‘ [+ Dimension Gap
[l Feature Control Frame "
s
i Hole Table Overshoot
o c
£ Layers
P Extension A,Z
‘ Leader -
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v~ Surface Texture g —
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A Text
1 view annotaton 4, Click the|Center P
Vel sl Mark (ANS|) option
D weld Bead
3. Click the + sign
¥ 5. Enter edit values
EE‘ |- Import 7. Save and Close ‘ ‘ Cancel

Figure 4-33

Changing the Background Color of the Drawing Screen

EB Click the Tools tab at the top of the screen.

Select the Application Options option.

The Application Options dialog box will appear. See Figure 4-34.
IE8 Click the Colors tab.
=¥ Click the desired color, then OK.

The background color will be changed. In this example the Presenta-
tion Color scheme and 1 Color Background were selected. This format is
used throughout the book for visual clarity.

E8 Click Apply and OK.
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Figure 4-34
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Isometric Views

An isometric view may be created from any view on the screen. The result-
ing orientation will vary according to the view selected. In this example, the
front view is selected.

EB Access the Create panel under the Place Views tab and click the

Projected View tool.
Click the Front orthographic view.

Move the cursor to the right of the front view and select a location for
the isometric view by clicking the mouse.

Move the cursor slightly and click the right mouse button.

Select the Create option.

Figure 4-35 shows the resulting isometric view. Isometric views help
visualize the orthographic views.



Figure 4-35

section view: A view used to
expose an internal surface of a
model.

cutting plane: A plane used to

define the location of a section view.

Figure 4-36

Rk

Views with
centerlines added

N

Resulting isometric view

Section Views

Some objects have internal surfaces that are not directly visible in nor-
mal orthographic views. Section views are used to expose these surfaces.
Section views do not include hidden lines.

Any material cut when a section view is defined is hatched using sec-
tion lines. There are many different styles of hatching, but the general style
is evenly spaced 45° lines. This style is defined as ANSI 31 and will be
applied automatically by Inventor.

Figure 4-36 shows a three-dimensional view of an object. The object
is cut by a cutting plane. Cutting planes are used to define the location
of the section view. Material to one side of the cutting plane is removed,
exposing the section view.

Section line

Cutting plane

Figure 4-37 shows the same object presented using two dimensions.
The cutting plane is represented by a cutting plane line. The cutting plane
line is defined as A-A, and the section view is defined as view A-A.

All surfaces directly visible must be shown in a section view. In
Figure 4-38, the back portion of the object is not affected by the section
view and is directly visible from the cutting plane. The section view must
include these surfaces. Note how the rectangular section blocks out part of
the large hole. No hidden lines are used to show the hidden portion of the
large hole.
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Cutting plane line

Figure 4-37

HATCH—\

|
|
<__.JA Side orthographic SECTION A-A
Front orthographic view view

Figure 4-38

Lorge hole

Only partially visikle

- @

Blocks view

of lorge hole
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khehlnd cuttlihg plane

Olrectly vishkle SECTION A-A

EXERCISE 4-6 Drawing a Section View Using Inventor

Figure 4-39 shows the front and top views of the object defined in
Figure P3-10. A section view will be created by first defining the cutting plane
line in the top view, then projecting the section view below the front view.

EN Click the Section View tool on the Create panel under the Place
Views tab, then click the top view.

The cursor will change to a +-like shape.

Figure 4-39 1. Click the Section View tool on the Create
panel located under the Place Views tab.

@ m Cliutting plane cursor

e

2. Define cutting plane line.

I_i_l
|
|
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IE8 Define the cutting plane by defining two points on the top view.

See Figure 4-39. Note that if you touch the cursor to the endpoint of one
of the hole’s centerlines, a dotted line will follow the cursor, assuring
that the cutting plane line is aligned with the holes’ centerlines.

N Right-click the mouse and select the Continue option.
The Section View dialog box will appear. See Figure 4-40.

Figure 4-40
Cutting plane line, note that the section view is located behind the arrows.
/
Sectfon View x
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[Ful v]  Omndudesice
2. Click the Continue : LJ . 4
Option i 6.35mm Slice The Whole Part
| |
O Zoom } i } i Method CutEdges
i M pan Il @ Projected ]
| l—!—l "+ Previous View F5 A =
' Preview
How To... P R
T e : @ o] e |
|
5| | L

IEB Set the Label letter for A, the Scale for 1:1, and Style for Hidden Lines.
IEB Move the cursor so as to position the section view below the front view.
IEB Click the section view location.

EA Add the appropriate centerlines using the Centerline Bisector tool.

Figure 4-41 shows the resulting section view. Notice that the section
view is defined as A-A, and the scale is specified. The arrows of the
cutting plane line are directed away from the section view. The section
view is located behind the arrows.

Figure 4-41

ALF!\ fi:‘\fn
v/ N

i
Y—{

Locate the section view
; ; behind the arrows on
Section view the cutting plane line.

Section lines

SECTION A-A
SCALE1:1
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Figure 4-42

Figure 4-43
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Offset Section Views

Cutting plane lines need not pass directly across an object, but may be oft-
set to include several features. Figure 4-42 shows an object that has been
cut using an offset cutting plane line.

Offset cutting
plane line

\No indication that
—— = —T  cutting plane line

changed direction
=
i
I

D SECTION D-D

EXERCISE 4-7 Creating an Offset Cutting Plane

Figure 4-43 shows the front and top views of an object. The views were cre-
ated using the Create View, Projected View, and Centerline tools.

EB Click the Section View tool, and click the top view.

8 Draw a cutting plane across the top view through the centers of each of
the three holes.

When drawing an offset cutting plane line, show the line in either hori-
zontal or vertical line segments.

[EB Locate the section view below the front view and add the appropriate
centerlines.

AL@J— @_JA §

An offset cutnng plane

Note: Inventor includes a line
whenever a cutting plane changes

direction. These lines may be
deleted.
! 2

ZECTION A-2
SCALEE 1




Aligned Section Views

Figure 4-44 shows an example of an aligned section view. Aligned section
views are most often used on circular objects and use an angled cutting
plane line to include more features in the section view, like an offset cutting
plane line.

Figure 4-44 ——A

) !

i .

& s, 7

_ 77

SECTION A-A

An aligned section view is drawn as if the cutting plane line ran
straight across the object. The cutting plane line is rotated into a straight
position, and the section view is projected.

Figure 4-45 shows an aligned section view created using Inventor.

An aligned cutting plane

o
N
7
N
N
SECTIOM A-A
. SCALCE: -
Figure 4-45
Detail Views
detail view: An enlarged view of a Detail views are used to enlarge portions of an existing drawing. The
portion of a model. enlargements are usually made of areas that could be confusing because of

many crossing or hidden lines.
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EXERCISE 4-8 Creating a Detail View

EN Click the Detail View tool on the Create panel under the Place Views
tab, then click the view to be enlarged.

In this example, the top view was selected.

The Detail View dialog box will appear. See Figure 4-46.

&
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I
I
|
1
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I
I
I
!

Figure 4-46

Figure 4-47
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_I | CETAL C Cutout Shape
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| Display Connection Line
[ | - S
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IEl Set the Label letter to D and the Scale to 2:1, then pick a point on the view.
EB Move the cursor, creating a circle.
The circle will be used to define the area of the detail view.

IE8 When the circle is of an appropriate diameter, click the left mouse but-
ton and move the cursor away from the view.

=8 Locate the detail view and click the location.

IEB Use the Center Mark tool to add a center mark to the circle in the
Detail drawing.

Break Views

It is often convenient to break long, continuous shapes so that they take
up less drawing space. Figure 4-47 shows a long L-bracket that has a
continuous shape; that is, its shape is constant throughout its length.
Figure 4-48 shows an orthographic view of the same L-bracket.
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Propagate to parent view
= [ coned |
The overall dimension remains
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Figure 4-48



EXERCISE 4-9 Creating a Broken View

EN Click the Break tool located on the Create panel under the Place
Views tab, then click the orthographic view.

The Broken View dialog box will appear.

IEl Select the orientation of the break and the gap distance between the
two portions of the L-bracket.

In this example, the gap distance is 1.00. Do not click the OK box.
Define the break with the Broken View dialog box on the drawing
screen.

D Click a point near the left end of the L-bracket, then move the cursor to
the right and click a second point near the right end of the L-bracket.

Figure 4-48 shows the resulting broken view.

Multiple Section Views

It is acceptable to take more than one section view of the same object to
present a more complete picture of the object. Figures 4-49 and 4-50 show
objects that use more than one section view.
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Figure 4-49 Figure 4-50

auxiliary view: An orthographic
view drawn perpendicular to a
slanted or oblique surface.

Auxiliary Views

Auxiliary views are orthographic views used to present true-shape views
of slanted surfaces. Figure 4-51 shows an object with a slanted surface
that includes a hole drilled perpendicular to the slanted surface. Note how
the right-side view shows the hole as an ellipse and that the surface A-B-
C-D is foreshortened; that is, it is not shown at its true size. Surface A-B-
C-D does appear at its true shape and size in the auxiliary view. The auxil-
iary view was projected at 90° from the slanted surface so as to generate a
true-shape view.

Figure 4-52 shows an object that includes a slanted surface and hole.
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An Auxiliary View

In the Auxiliary view the

This hidden B hole appears as a circle
line is the

bottom left
edge

Foreshortened surface

AB B

/ / /‘J
i D!C D~ ; —C

i

4’;‘
\ Edge generates a hidden

line in the Auxiliary view

Figure 4-51

An object with hole perpendicular
to the slanted surface

Figure 4-52

DAL{ENFRON Drawing an Auxiliary View

EN Create a drawing using the ANSI (mm).ipt format. Click the Base View
and Projected View tools on the Create panel under the Place Views
tab, and create a front and a right-side view as shown in Figure 4-53.

Click the Auxiliary View tool, then the front view.
IE8 The Auxiliary View dialog box will appear.

D Enter the appropriate settings, then click the slanted edge line in the
front view.

In this example, a scale of 1:1 was used.

IEB Move the cursor away from the front view and select a location for the
auxiliary view.

=3 Click the left mouse button and create the auxiliary view.
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Figure 4-53

The hole cuts the back
surface, generating an

elliptical shape. \

Auxiliary View

Yiew | Scale Label Skyle

View Identifisr Scale

|E ‘ |1:1 v‘

Enter values.

D Definition in Base Yiew

([ENEEE

Drag the cursor away from
the selected line. .

A front and a right side orthographic view
of the object shown in Figure 4-52.

Select this line.

Note how the hole cuts through
the back surface.

Click on & location

Select a location for the auxiliary view.

Auxiliary view

A true view of the
slanted surface

Auxiliary View

View [ Scale Label

View Identifier Scale

. 112 ]

@ |Z Edit values if necessary

[ pefinition in Base View

Style

x

@ V| et oK

| | Cancel

Chapter 4 | Orthographic Views

189



ASME Y14.3-2003
Drawing Standards

There are two sets of standards used to define the projection and place-
ment of orthographic views: the ANSI and the ISO. The ANSI calls for
orthographic views to be created using third-angle projection and is the
accepted method for use in the United States. See the American Society of
Mechanical Engineers (ASME) publication ASME Y14-3-2003. Some coun-
tries other than the United States use first-angle projection. See ISO publi-
cation 128-30.

This chapter has presented orthographic views using third-angle pro-
jections as defined by ANSI. However, there is so much international com-
merce happening today that you should be able to work in both conven-
tions, just as you should be able to work in both inches and millimeters.

Figure 4-54 shows a three-dimensional model and three orthographic
views created using third-angle projection and three orthographic views
created using first-angle projection. Note the differences and similarities.
The front view in both projections is the same. The top views are the same,
but are in different locations. The third-angle projection presents a right
side view, whereas the first-angle projection presents a left side view.

Figure 4-54

3D Model

Third-angle projection

Top

Front Right side

Symbol for third-
angle projection
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Figure 4-54
(Continued)

Front Left side

Symbol for first-
angle projection

First-angle projection

Top
Symbol for third-angle projection
Figure 4-55 shows the drawing symbols for first- and third-angle
projections. These symbols can be added to a drawing to help the reader
understand which type of projection is being used. These symbols were
included in the projections presented in Figure 4-54.

Symbol for first-angle projection | Third- and First-Angle Projections

Figure 4-56 shows an object with a front orthographic view and two side
orthographic views: one created using third-angle projection, and the
other created using first-angle projection. For third-angle projections, the
orthographic view is projected on a plane located between the viewer’s
Figure 4-55 position and the object. For first-angle projections, the orthographic view

V2N
= W7

Front view

= B b

Front view Right side view Left side view
Third-angle projection First-angle projection

Figure 4-56
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Third-angle projection Look through the
: : object onto a plane

First-angle
projection
Project views onto
planes directly

Figure 4-57 Figure 4-58

is projected on a plane located beyond the object. The front and top views
for third- and first-angle projections appear the same, but they are located
in different positions relative to the front view.

The side orthographic views are different for third- and first-angle pro-
jections. Third-angle projection uses a right side view located to the right of
the object. First-angle projections use a left side view located to the right of
the object. Figures 4-57 and 4-58 show the two different side view projec-
tions for the same object. For third-angle projection, the viewer is located
on the right side of the object and creates the side orthographic view on a
plane located between the view position and the object. The viewer looks
directly at the object. For first-angle projection, the viewer is located on
the left side of the object and creates the side orthographic view on a plane
located beyond the object. The viewer looks through the object.

To help understand the difference between side view orientations for
third- and first-angle projections, locate your right hand with the heel fac-
ing down and the thumb facing up. Rotate your hand so that the palm
is facing up—this is the third-angle projection orientation. Return to the
thumb up position. Rotate your hand so that the palm is down—this is the
first-angle view orientation.

To create first-angle projections using Inventor:

EN Start a New drawing using the ISO.idw template.
This template will automatically create first-angle projection drawings.
=3 Click the Base tool.
[EB Select the appropriate file.
EB Select the orientation.
IE8 Use the Projected View tool to select and position the views (Figure 4-59).
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Figure 4-59
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Chapter Summary

This chapter introduced orthographic drawings using third-angle projec-
tion in accordance with ANSI standards. Conventions were demonstrated
for objects with normal surfaces, hidden lines, slanted surfaces, compound
lines, oblique surfaces, and rounded surfaces.

Inventor creates orthographic views directly from models. The tools on
the Create panel and the Annotate panel were introduced for managing
orthographic presentation views. Isometric views can also be created from
models.

Section views are used to expose internal surfaces that are not directly
visible in normal orthographic views. Cutting planes were used to define
the location of section views. Offset and aligned section views also were
created.

Techniques for creating detail views, broken views, and auxiliary views
were demonstrated as well.

Chapter Test Questions

Multiple Choice
Circle the correct answer.
1. Which of the following is not one of the three views generally taken of

an object?
a. Front
b. Top
c. Left
d. Right

2. In the precedence of lines, a hidden line covers a(n) ____line.
a. continuous
b. center
c. compound

d. oblique

3. Which of the following is used to define a section view?
a. A cutting plane
b. A section line
c. A centerline
4. Section lines are used to define which of the following on a section
view?
a. The outside edges of the section cut
b. The location of the section view

c. The areas where the section view passes through solid material
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(b) (©

Figure MC4-1

. Given the model shown in Figure MC4-1, which is the correct top view?

a. b. C.

. Given the model shown in Figure MC4-1, which is the correct front
view?
a. b. c.

. Given the model shown in Figure MC4-2, which is the correct top
view?

a. b. C.

. Given the model shown in Figure MC4-2, which is the correct right-side
view?

_®_ _ _®_

Figure MC4-2

(T ) aiEh
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| | | | | | | | |
| | | | | |
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L 1 1 | 1 Y F YN Y=
(b) (c)
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9. Given the model shown in Figure MC4-2, which is the correct top view?

a. b. C.

10. Given the model shown in Figure MC4-2, which is the correct front
view?

a. b. C.

Matching

Given the drawing shown in Figure MC4-3, identify the types of lines used to
create the drawing.

Column A Column B

1. Centerlines

2. Cutting plane line
3. Continuous line
4. Section line

5. Hidden line
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True or False

Circle the correct answer.

1.

10.

True or False: Orthographic views are two-dimensional views used to
define three-dimensional models.

. True or False: Normal surfaces are surfaces located 90° to each other.
. True or False: Hidden lines are not used in orthographic views.

. True or False: A compound line is formed when two slanted surfaces

intersect.

. True or False: An oblique surface is a surface that is slanted in two

different directions.

. True or False: Center points cannot be edited; they can be used only

as they appear on the drawing screen.

. True or False: A section view can be taken only across an object’s cen-

terline.

. True or False: Aligned section views are most often used on circular

objects.

. True or False: A detail view is used to enlarge portions of an existing

drawing.

True or False: Break views are used to shorten long continuous shapes
so they can fit within the drawing screen.
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Chapter Project

Project 4-1

Draw a front, a top, and a right-side orthographic view of each of the
objects in Figures P4-1 through P4-24. Make all objects from mild steel.

STEPPER

10
SETTER <
/&40 BRACKET ’/ '/10 - ALL ARDUND

7

30

\ 40 -2 PLACES

40 &
15 25
%0 60\/ 100
30 30 -2 PLACES
Figure P4-1 Figure P4-2
MILLIMETERS MILLIMETERS

10 - BOTH SIDES
S0 >>§
\>/ \/40

MATL = 10mm SAE 1020 STEEL

Figure P4-3 Figure P4-4
MILLIMETERS MILLIMETERS
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Figure P4-9
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Figure P4-8
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Figure P4-11
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o
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Figure P4-12
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Project 4-2

Draw at least two orthographic views and one auxiliary view of each of the
objects shown in Figures P4-25 through P4-36.

20

Figure P4-25 Figure P4-26
MILLIMETERS MILLIMETERS

@ 20—THRU
PERPENDICULAR TO A

Figure P4-27 Figure P4-28
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Figure P4-29 Figure P4-30
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@50

12-4 PLACES

REGULAR HEXAGON
80 ACROSS THE CORNER

Figure P4-31 Figure P4-32
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CIRCLE IS A
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80 s 15
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20
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THE FLATS
Figure P4-33 Figure P4-34
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ALL FILLETS AND ROUNDS =R3

Figure P4-35 Figure P4-36
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Project 4-3

Define the true shape of the oblique surfaces in each of the objects shown
in Figures P4-37 through P4-40.

ALL FILLETS AND ROUNDS =R3

Figure P4-37 Figure P4-38
INCHES MILLIMETERS
16 .

125

@8

20 DEEP
Figure P4-39 Figure P4-40
INCHES MILLIMETERS
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Project 4-4

Draw each of the objects shown in Figures P4-41 through P4-44 as a
model, then draw a front view and an appropriate section view of each.

\\
A; )

\

’ L —— ¢ 13
¢ 25 x 82" CSK

A

—- 20

All around

Figure P4-41
MILLIMETERS

Figure P4-43
MILLIMETERS

e
¢ 13
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All around
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Project 4-5

Draw at least one orthographic view and the indicated section view for
each object shown in Figures P4-45 through P4-50.

@12
3 Places

30
R Centerline
of object

Figure P4-45
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Figure P4-47
INCHES
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Project 4-6

Given the orthographic views in Figures P4-51 and P4-52, draw a model
of each, then draw the given orthographic views and the appropriate
section views.

7.00
— A B C
—t - + + — 4+— 2200 @300
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=
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Figure P4-52
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Project 4-7

Draw a 3D model and a set of multiviews for each object shown in
Figures P4-53 through P4-60.

21.50
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Hiss
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Project 4-8

Figures P4-61 through P4-66 are orthographic views. Draw 3D models
from the given views. The hole pattern defined in Figure P4-61 also applies

to Figure P4-62.

NOTE: HOLE FATTERN IS THE SAME FOR THE
GASKET, GEAR HOUSING, AND GEAR COVER.

NCTE: OBIECT 15 SYMMETRICAL ABOUT 290.00
THE HORIZONTAL CENTER LIME. : R110.00
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e e i i i -1
E 4 e
,/'
f/ .
,\\
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Figure P4-61
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Figure P4-62
MILLIMETERS

@20.00
2 HOLES

EG.00 110.00 110.00 1E5.00

I8x1.35 - 6H x 30 DEEP
14 HOLES

NOTE: QBIECT IS SYMMETRICAL
ABOUT THE HORIZONTAL CEMTER. LINE.

st ~)

p
NZEN

R22.00

@ @ @ &
NOTE: ALL FILLETS AND ROUNDS R22.00 \— 232.00 i
R = 10 UNLESS CTHERWISE SPECIFIED. 3 HOLES 3 BDIESES

S f
A/%V Al AT = T

SECTION A-A
SCALE1/2

Figure P4-63 3.00
INCHES

ALL HOLES

R0L25
BOTH
SIDES

1/4-20 UNC = 0.75 - 12 HOLES

RO.25 BOTH BOSSES

I g
| |
1.75 /* | 3 | y ‘
5*38— /7/ | % 053
[ I I
SECTION A-A
SCALE 3/ 4

Chapter 4 | Orthographic Views 215
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Project 4-9

Figures P4-67 through P4-71 are presented using first-angle projection
and ISO conventions.

A. Create a solid model from the given orthographic views.

B. Draw front, top, and right-side orthographic views of the objects using
third-angle projection and ANSI conventions.
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Figure P4-69
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Figure P4-71
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Index

0°, defined, 31

A

Abbreviations, in dimensioning, 427
Addendum, in gears, 698, 699
Aligned dimensions, 52, 403-404
Aligned section views, 185
All-around fillet welds, 789-790
American National Standards Institute (ANSI), 167
on dimensions, 389, 390, 395
on orthographic views, 190-191
on threads, 312, 313, 319
American Society of Mechanical Engineers
(ASME), 190
American Standard
clearance locational fits, 824
interference locational fits, 827
running and sliding fits (hole basis), 825
transition locational fits, 826
Angled work planes, 129-132
Angle option, in Constrain tool, 231-232
Angular dimensions, 391, 413
Angularity tolerances, 509
Angular shapes, drawing, 19-20
Angular tolerances, 463-465
Animate tool, 238
Animating the LINKS, 272
Annotate panel, 177-178, 393
ANSI. See American National Standards
Institute (ANSI)
Applications Option dialog box, 3, 4, 179
Arcs, sketching, 36-38
ASME (American Society of Mechanical
Engineers), 190
Assemble panel bar, 223
Assembly drawings, 221-287
aligning, 278-279
Animate tool for, 238
Balloon tool for, 241-243
bottom-up assemblies, 221
Constrain tool for, 227-233
copying components in, 266-267, 286-287
creating and assembling parts, 261-263, 269-271
CROSSLINK, 268-269, 278
Degrees of Freedom option and, 224-226
drawing sheets for, 253-255
editing, 280-284
Free Move tool, 226
isometric, 238-241
LINKs, 264-267, 270-272, 275-277
mirroring components in, 285-286
numbers in, 241-243
Parts List tool for, 243-245

patterning components in, 284-285

plate, 272-275

presentation drawings, 235-237, 279-280

Rotate Component tool for, 227

saving, 234

sketch plane changes in, 261

springs in, 582-587

starting, 222-224, 260-261

subassemblies, 249-252

title blocks for, 246-248, 255-258

top-down assemblies, 221, 260-280

weldments, 3

work points and axes in, 263-264
Auxiliary views, 187-189

Backgrounds
gradient backgrounds, 29
grid backgrounds, 29
screen, changing color of, 3, 179-180
Backlash, defined, 698
Ball bearings, 671, 677-681
Balloon tool, 241-243
Baseline dimensions, 418-419, 468-469
Bearings, 671-685
ball, 671, 677-681
interface, 675
plain, 671, 672-676
thrust, 671, 681-685
Belleville springs, 580-582
Bend radii, 751-753
Bevel gears, 698, 718-725
Bilateral tolerances, 455-456
Bisector tool, for centerlines, 178, 183

Blind holes, 98, 317-319, 321-322, 324-325

Bolt circles, 57

Bolts, 322, 323, 325-332
Bottom-up assemblies, 221
Break views, 186-187
Bubble numbers, 242
Bushings. See Plain bearings

C

Callouts, in threads, 312-314
Cams, 799-814
defined, 799
displacement diagrams and, 799, 800
drawing, 801-803, 806-809
followers and, 809-814
hole additions to, 803-805
Center distance, of gears, 698
Centerline Bisector tool, 178, 183

823



Centerlines Create In-Place Component dialog box, 261,

adding, 176-178 262, 264
dimensioning, 430 Create New File dialog box, 2, 27-28, 235
editing, 179 Crest, of threads, 312
for holes, 394-395 CROSSLINK, 268-269, 278
symbols, 427-428 Cuts, in sheet metal drawings, 757-759
Center Point Arc tool, 38, 51 Cutting planes, 181, 184
Chain dimensions, 467-468 Cylinders, 128, 139
Chamfers drawing a work axis at center of, 139
defined, 46, 425 Cylindrical fits
dimensioning, 425 hole basis, 828
on shafts, 606-610 shaft basis, 830
sketching, 46-48 Cylindricity tolerances, 495-496

Chamfer tool, 104-105
Change orders (COs), 258

Circle Center Point tool, 33-34 D
Circles Datums, 498, 504-505
location and size changes, 68-70 Datum surfaces, 480
patterns of, 57-58, 113-114 Dedendum, defined, 698
sketching, 33-35, 142 Default planes and axes, 123-125
Circle Tangent tool, 35 Degrees of Freedom option, 224-226
Circle tool, 12, 17, 34-35 Design tab, 648-651
Circularity tolerances, 495 Detail views, 185-186
Circular Pattern dialog box, 57 Deviation tolerances, 455
Circular Pattern tool, 113-114 Dialog boxes. See specific dialog boxes
Circular pitch, 698 Diameter dimensions, 404-406
Circular thickness, 698 Diametral pitch, 697, 699
Clearance, of gears, 699 Dimension lines, 390
Clearance fits, 474-475 Dimensions and dimensioning, 389-435
Clearance locational fits, 824 aligned, 52, 403-404
Closed splines, 39 angular, 391, 413
Coil tool, 146-148, 563-565, 568, baseline, 418-419, 468-469
572, 579 centerlines, 430
Collars, 638-643 chain, 467-468
Columns, for parts lists, 245-246 chamfers, 425
Compound lines, 171-172 drawing, 389, 392-393
Compression springs, 563-570 drawing scales and, 399-400
coil ends, 565-570 editing, 8-9
drawing, with coil tool, 563-565 errors to avoid, 391-392
Constrain tool, 227-233 fillets and rounds, 422-423
Angle option, 231-232 holes and hole tables, 397-399, 406-407, 411-412,
Flush option, 227-228 419-420
Insert option, 233 horizontal, 394-395
Mate option, 227-228 irregular surfaces, 423-424
Offset option, 229 keys and keyseats, 426-427
overview, 227 knurls, 426
positioning objects with, 229-230 linear, 391, 472-473
Tangent option, 232 locating, 421-422
Constraints, 52-55 model, 389, 393
Content Center, 311, 333, 339-340, 342, ordinate, 415-417
345, 611, 643, 646 orthographic views, 393, 429-430
Copy Component tool, 286-287 overall, 395
Copy tool, 62-63, 266 to points, 428-429
Corners, in sheet metal drawings, 756-757 polar, 424-425
COs (change orders), 258 radius and diameter, 404-406
Counterbores, 336-339, 411-412 rectangular, 470
Countersunk holes, 333-337, 413 reference, 408
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section views, 429
symbols and abbreviations, 409-411, 427-428
terminology and conventions for, 390-392
text, 396-397, 406
3D, 430-431
types of, 389
units, 400-402
vertical, 395-396
Dimension tool, 34, 37, 49, 52, 389, 407
Disc Cam tool, 799, 801
Displacement diagrams, 800
Double dimensioning, 413, 466-467
Drawing dimensions, 389, 392-393
Drawing layout files, 3
Drawing notes, 259
Drawing revisions, 258
Drawings. See also Sketches
assembly drawings, 221-287 (See also Assembly
drawings)
sheet metal, 747-768 (See also Sheet metal drawings)
starting, 1-3
weldment (See Weldment drawings)
Drawing scales, 399-400
Drawing sheets, 253-255
Drawing View dialog box, 175, 239, 240
Drill sizes, 479
Drive Constraint dialog box, 273

E

ECOs (engineering change orders), 258-259
Edit Dimension dialog box, 8, 68, 69, 458, 459
Edit Feature tool, 120
Editing
arcs, 37
assembly drawings, 280-284
balloons, 242
centerlines, 179
dimensions, 8-9
features, 89-90, 280-282
hole dimensions, 399
parts lists, 244-245
splines, 39-40
3D modeling, 88-90, 120-123
2D sketching, 68-69
Edit Sheet dialog box, 253
Edit Sketch tool, 120
Ellipses, sketching, 40-42
Ellipse tool, 42
Engineering change orders (ECOs), 258-259
Equilateral polygon, 48
Esc key, 31
Exploded assembly drawings, 235-237
Extend tool, 66-67
Extension lines, 390
Extension springs, 570-577
External rounded shapes, 423

Extrude dialog box, 10, 12, 85, 88, 90
Extrude tool, 10, 12, 15-16, 85-87, 621

F

Face Draft tool, 105-106
Face fillets, 101-103
Face width, 698
Fasteners, 322-352
accessing, 311
bolts, 325-332
counterbores and, 336-339
fixed, 517
floating, 514-515
hole designs based on size of, 490
length and depth determinations, 324-328
nuts, 328-332, 343-345
rivets, 351-352
screws, 328-329, 332-336, 339
setscrews, 348-351, 638-641
standard specifications for, 322-323
tolerances and, 490
washers, 345-348
Feature Control Frame dialog box, 498,
500, 502
Feature editing, 89-90, 280-282
Features, defined, 90
File extensions, 3
Fillets
adding, 123
defined, 44
dimensioning, 422
face fillets, 101-103
full round fillets, 100-101
sketching, 45-46
variable fillets, 103
Fillet tool, 99-103
Fillet welds, 779-786, 789-790
First-angle projections, 191-193
Fits, and tolerances, 474-476, 478-479
Fixed condition, 488-489
Fixed fasteners, 517
Flanges, 91-93, 753-754
Flat head screws, 333-337
Flatness tolerances, 491
Flat Pattern tool, 761
Flip tool, 57
Floating condition, 487-488
Floating fasteners, 514-515
Floating objects, 473
Flush option, in Constrain tool, 227-228
Followers, 809-814
Fonts, changing, 51
Format Text dialog box, 398
Free Move tool, 226
Free Orbit tool, 20
Full round fillets, 100-101

Index
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826

G

Gauges, wire and sheet metal, 823
Gear ratios, 706-707
Gears, 697-731
assemblies, 712
bevel, 698, 718-725
combinations of, 707-708
direction of, 708
drawing, 699-701
formulas for, 699
hub additions to, 701-706, 719-721
with keyways, 709-712, 721-723
meshing, 697, 708, 712, 718
ratio between, 706-707
spur, 698, 699-701, 709
terminology, 697-699
worm, 698, 726-729
Gear trains, 707-708
Geometric tolerances, 491, 496-500, 503
Geometry Text tool, 51-52
Get Started panel, 1, 2
Gradient backgrounds, 29
Grid backgrounds, 29
Groove welds, 791-792
Grounded components, 224

H

Hatch tool, 426
Height of text, changing, 51
Hexagons
defining size of, 49
sketching, 48-49
Hex head bolts, 325-327
Hex head screws, 329, 340
Hidden lines, 169-170
Hole-basis tolerances, 476-478, 679-689
Hole dialog box, 320, 321
Holes
adding, 10-12, 17-19
blind holes, 98, 317-319, 321-322, 324-325
in cams, 803-805
centerlines for, 394-395
counterbores, 336-339, 411-412
countersunk, 333-337, 413
in cylinders, 128
diameter changes, 121
dimensioning, 397-399, 406-407, 411-412, 419-420
fastener size and, 490
in sheet metal drawings, 755-756, 760-761
through holes, 96-97, 320-321
tolerances and, 470-473
Hole tables, 419-420
Hole tool, 319-321
Home tool, 21
Horizontal dimensions, 394-395
Hubs, gear, 701-706, 719-721

Index

Idler gears, 708

Insert option, in Constrain tool, 233

Interference fits, 474, 475

Intermittent fillet welds, 786

Internal rounded shapes, 422-423

Internal threads, 315-316

International Organization for Standardization
(Iso), 167, 190, 389, 390

Irregular surface dimensioning, 423-424

ISO. See International Organization for
Standardization (ISO)

Isometric drawings, 238-241

Isometric 3D view, 9

Isometric position, returning to, 21

Isometric views, 180-181

K

Keys, 616-622
defined, 426
dimensioning, 426427
Pratt and Whitney, 622-628
square, 426, 617-622, 628
Woodruff, 629-632
Keyways
creating, 621-622, 625-628
defined, 426
dimensioning, 426-427
gears with, 709-712, 721-723
plain groove, 628
on shafts, 616-622
Knurls, 426

L

Lay, defined, 481
Lay symbols, 485-486
Leader lines, 391
Length of models, changing, 120-121
Limits/Fits Calculator, 475-476, 479
Limit tolerances, 455, 462-463
Linear dimensions, 391, 472-473
Lines

compound, 171-172

defining lengths of, 31-33

hidden, 169-170

precedence of, 170-171
Line tool, 29-31
LINKs, 264-267, 270-272, 275-277
Locating dimensions, 421-422
Loft tool, 141-143

M

Major diameter, of threads, 312
Mate option, in Constrain tool, 227-228
Material designations, 148-149



Maximum material condition (MMC), 493, 494,
507, 514-515

Meshing gears, 697, 708, 712, 718

Minor diameter, of threads, 312

Mirror Component tool, 285-286

Mirror tool, 59-60, 111-112

MMC. See Maximum material condition (MMC)

Model dimensions, 389, 393

Modeling. See 3D modeling

Module, in gears, 698

Mouse wheel, 224, 226

Move tool, 60-62

Multiple section views, 187

New File dialog box, 2

Nominal sizes, 474

Normal surfaces, 168-169

Number of teeth, in gears, 698, 699
Numbers, in assembly drawings, 241-243
Nuts, 328-332, 343-345

o

Oblique surfaces, 172
Oblique work planes, 136-137
Offset option, in Constrain tool, 229
Offset section views, 184
Offset tool, 67-68, 142, 143
Offset work planes, 132-134
Open dialog box, 175, 236
Open splines, 39
Ordinate dimensions, 415-417
O-rings, 643-648
Orthographic views, 167-193
auxiliary, 187-189
break, 186-187
centerlines and, 176-178
creating, 173-176
defined, 167
detail, 185-186
dimensioning, 393, 429-430
drawing standards for, 190-191
fundamentals of, 168-173
isometric, 181-182
section, 181-183, 187
third- and first-angle projections, 191-193
Outside diameter, 698
Overall dimensions, 395
Overdimensioning, 414-415, 466-467

P

Parallelism tolerances, 508

Part files, 3

Parts List tool, 243-245

Path, creating, 146

Pattern Component tool, 284-285

Patterns
circular, 57-58, 113-114
Mirror tool for, 59-60
rectangular, 55-57, 112-113
for 2D sketching, 55-60
Perpendicularity tolerances, 498-499, 505-508
Pins, 641-643
Pitch, of threads, 312-313, 319
Pitch diameter, 697, 699
Place Component dialog box, 223
Place Constraint dialog box, 227, 228, 231-233
Place Views tool, 239
Plain bearings, 671, 672-676
Plain groove keyways, 628
Plate, in assembly drawings, 272-275
Plus and minus tolerances, 455-462
Points, dimensioning to, 428-429
Point tool, 43
Polar dimensions, 424-425
Polygons, sketching, 48-49
Positional tolerances, 500-502, 512-513
Power Transmission panel, 625-628, 648
Pratt and Whitney keys, 622-628
Preferred clearance fits
cylindrical fits (hole basis), 828
cylindrical fits (shaft basis), 830
Preferred pitches, 698
Preferred transition and interference fits
hole basis, 829
shaft basis, 831
Presentation drawings, 235-237, 279-280
Presentation files, 3
Pressure angles, 699
Profile tolerances, 509-510
Punch tool, 762-768

R

Radius dimensions, 404-406
Rectangles

patterns of, 55-57, 112-113

sizing, 6-8

sketching, 4-6, 43-44
Rectangular dimensions, 470
Rectangular Pattern dialog box, 57
Rectangular Pattern tool, 112-113
Reference dimensions, 408
Regardless of feature size (RFS) application, 493,

494, 507
Release blocks, 255
Reliefs, in sheet metal drawings, 755
Restoring work planes, 129
Retaining rings, 611-616
Revision blocks, 256-258
Revolve tool, 94-96
RFS. See Regardless of feature size (RFS)
application

Ribs (webs), 139-141

Index
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Rivets, 351-352

Root, of threads, 312

Root diameter, 698

Rotate Component tool, 226, 227
Rotate tool, 64-65

Rotating objects, 20-21
Roughness, defined, 481
Rounded surfaces, 172-173
Rounds, dimensioning, 422-423
Running and sliding fits (hole basis), 825
Runout tolerances, 510-512

S

Save As command, 12

Screen background, changing color of, 3, 179-180

Screws, 328-329, 332-336, 339, 340-341
Section views

aligned, 185

defined, 181

dimensioning, 429

drawing, 182-183

multiple, 187

offset, 184
Select Assembly dialog box, 236
Setscrews, 348-351, 638-641
Shaft-basis tolerances, 476-478, 679-681
Shafts, 605-651

collars and, 638-643

Design tab for, 648-651

interface, 675

keys and, 616-622

o-rings and, 643-648

retaining rings and, 611-616

with splines, 632-638

uniform shafts with chamfered ends, 606-610
Shaft tolerances, 672-673
Sheet metal drawings, 747-768

bend radii and, 751-753

corners in, 756-757

creating, 747-749

cuts in, 757-759

flanges and, 753-754

Flat Pattern tool for, 761

holes in, 755-756, 760-761

Punch tool for, 762-768

reliefs and, 755

tabs and, 754-755

thickness added to, 749-751
Sheet metal gauges, 823
Shell tool, 107-108
Simple holes, 96
Sketches. See also Drawings; 2D sketching

creating, 4-6, 146-148

defined, 90

editing, 88-89, 280-284
Sketch panel, 27-29, 621
Sketch planes, 114-119, 261

Index

Slanted surfaces, 171
Sleeve bearings. See Plain bearings
Slots, 422
Solid modeling. See 3D modeling
Splines
defined, 39
editing, 39-40
shafts with, 632-638
sketching, 39
Split tool, 109-110
Springs, 563-604
in assembly drawings, 582-587
Belleville, 580-582
compression, 563-582
extension, 570-577
torsion, 577-580
Spur gears, 698, 699-701, 709
Square keys, 426, 617-622, 628
Squares
projecting, 143
sketching, 142
Standard tolerances, 465-466
Straightness tolerances, 492-495, 499-500
Style and Standard Editor dialog box, 396, 403,
460, 465
Subassemblies, 249-252
Supports
for bevel gears, 724-725
for worm gears, 728-729
Surface finishes, 480-486
Surface texture, 480
Sweep tool, 144-146
Symbols
datum, 505
dimensioning, 409-411, 427-428
surface control, 482-484
weldment drawings, 787-789
Symbols panel, 177, 178
Symmetric tolerances, 456

T

Tabs, in sheet metal drawings, 754-755
Tangent Arc tool, 37
Tangent option, in Constrain tool, 232
Tangent work planes, 127-128
Tapering, 87-90
T-brackets, 784
Text
dimensioning, 396-397, 406
font and text height changes, 51
positioning, 396-397
unidirectional, 395-396
Text tool, 49-52
Third-angle projections, 191-193
Threads, 311-322
accessing, 311
blind holes for, 317-319, 321-322, 324-325



callouts, 312-314

Hole tool for, 319-321

internal, 315-316

representations of, 314-315

terminology for, 312
3D dimensioning, 430-431
3D modeling, 85-149

Chamfer tool for, 104-105

Circular Pattern tool for, 113-114

Coil tool for, 146-148

default planes and axes in, 123-125

editing, 88-90, 120-123

Extrude tool for, 10, 12, 15-16, 85-87

Face Draft tool for, 105-106

Fillet tool for, 98-103

holes in, 10-12, 17-19, 96-98

Loft tool for, 141, 143

material designations for, 148-149

Mirror tool for, 111-112

Rectangular Pattern tool for, 112-113

Revolve tool for, 94-96

ribs (webs) in, 139-141

saving, 12

Shell tool for, 107-108

sketch planes and, 114-119

Split tool for, 109-110

starting, 9-12

Sweep tool for, 144-146

tapering in, 87-90

ViewCube and, 90-93

work axes in, 135, 138-139

work planes in, 125-134

work points in, 135-137
Three-point arc tool, 36-37
Three Point Rectangle tool, 44
Through holes, 96-97, 320-321
Thrust bearings, 671, 681-685
Title blocks, 246-248, 255-258
Tolerances, 455-521

analysis of, 469-470

angular, 463-465

angularity, 509

chain and baseline dimensions and,

468-470

circularity, 495

cylindricity, 495-496

datums and, 498, 504-505

defined, 455

design problems and, 486-487, 519-521

direct methods, 455-456

double dimensioning and, 466-467

expressions, 457

fastener size and, 490

fits, 474-476, 478-479

fixed condition and, 488-489, 517

flatness, 491

floating condition and, 487-488, 514-515

of form, 491

geometric, 491, 496-500, 503

hole and shaft, 478, 679-681

holes and, 470-473

limit, 455, 462-463

linear dimensions and, 472-473

nominal sizes and, 474

of orientation, 504

parallelism, 508

perpendicularity, 498-499, 505-508

plus and minus, 455-462

positional, 500-502, 512-513

profile, 509-510

rectangular dimensions and, 470

runout, 510-512

shaft, 672-673

standard, 465-466

straightness, 492-495, 499-500

surface finishes and, 480-486

virtual condition and, 514
Tolerances of form, 491
Tolerances of orientation, 504
Tolerance studies, 469-470
Top-down assemblies, 221, 260-280
Torsion springs, 577-580
Trails, hiding, 237
Transition fits, 474, 475
Transition locational fits, 826
Trim tool, 37, 65-66
Tweak Components tool, 236-237
2D sketching, 27-76

arcs, 36-38

chamfers, 46-48

circles, 33-35

Constrain panel in, 52-55

Copy tool in, 62-63

Dimension tool in, 34, 49, 52

editing, 68-69

ellipses, 40-42

Extend tool in, 66-67

fillets, 45

hexagons, 48-49

Line tool in, 29-31

Mirror tool in, 59-60

Move tool in, 60-62

Offset from Plane tool, 142, 143

Offset tool in, 67-68

patterns for, 55-60

Point tool in, 43

polygons, 48-49

rectangles, 4-6, 43-44

Rotate tool in, 64-65

Sketch panel for, 27-29

splines, 39

Text tool in, 49-52

Trim tool in, 37, 65-66
Two Point Rectangle tool, 43

Index
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1) fillet welds, 779-786, 789-790
groove welds, 791-792
symbols, 787-789
Whole depth, 698
Wire gauges, 823
Woodruff keys, 629-632
Work axes, 135, 138-139, 263-264, 271,
584-587
Working depth, 698
Work planes, 125-134

U-brackets, 675-676

Undo tool, 9, 88

Unidirectional text, 395-396
Unified screw threads, 313-314
Uniform shafts, 606-610
Unilateral tolerances, 455-456
Units, dimensioning, 400-402

v angled, 129-132
Variable fillets, 103 defined, 125
Vertical dimensions, 395-396 help features for, 125-126
ViewCube, 90-93 hiding, 129
Views. See Orthographic views oblique, 136-137
Virtual condition, 514 offset, 132-134
restoring, 129

w tangent, 127-128

Work points, 135-137, 263-264
Washers, 345-348 Worm gears, 698, 726-729

Webs (ribs), 139-141

Weldment drawings, 779
creating, 792-793
defined, 779
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